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for Windows
Software User Guide
•	ZoomBrowser EX
•	PhotoStitch

How to Use This Manual

New Features in This Version

Click a tab to jump 
to that chapter. 
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About this Manual

Notation Conventions

The contents of this manual are classified according to the following symbols. 

 IMPORTANT
•	The “Important” sections contain operating precautions or important topics. 

Ensure that you read them. 

 HINT
•	 The “Hint” sections contain procedural suggestions and tips for your convenience. Read them as 
necessary.

Operating Environment

•	This manual uses Windows XP screen shots and procedures in the explanations. The 
screen shots and procedures may appear slightly different if you are using another 
version of Windows.

• The displayed screens and procedures may also differ slightly from the examples 
depending upon the camera or printer model in use.

•	The explanations in this guide are based on the premise that a Canon compact 
camera will be used with the software. 

Word Searches

This document is provided as an Adobe Reader document. Use Adobe Reader’s Search 
functions to find specific words or phrases that you recall but cannot find. To access 
this function, in Adobe Reader click the [Edit] menu and select the [Search] option. 

If you are using Adobe Reader 8 or later, you can also perform searches with the [Find] 
function right on the toolbar. 

Input search text here
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This page and the next present the basic functions of ZoomBrowser EX as well as some 
of its special features.

To Download

Downloading 
(p. 10)

Download images 
with a single click.
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100-0035
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/09

To Print

Printing 
(p. 13)

Print with the layouts you want. 

To View

Magnifying 
the Display 
(p. 21)

Displaying 
Shooting 
Information 
(p. 21)

Comparing 
Images  
(p. 40)

Slideshows 
(p. 34)

To Organize

Backing Up 
to a CD  
(p. 32)

Changing 
File Names in 
Batches  
(p. 35)

Using Star Ratings  
(p. 36)

Deleting  
(p. 19)

Using Comments  
(p. 36)

Performing 
Searches  
(p. 38)

Next

XYZ123ABC

xxx_03xxx_02xxx_01
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RAW

To Edit

Adjusting 
Color and 
Brightness 
(p. 23)

Red-Eye 
Correction 
(p. 22)

Inserting 
Text  
(p. 24)

Trimming 
(p. 24)

Converting 
RAW Images 
(p. 28)

Merging Images 
into Panoramas 
(p. 27) 

Formatting 
Images as 
Wallpaper  
(p. 31) 

Extracting Still 
Images from 
Movies  
(p. 30) 

Resizing 
Images  
(p. 29) 

Editing Movies 
(p. 27)

To Connect to a Camera 

Uploading 
to a Camera  
(p. 45) 

Configuring My 
Camera Settings  
(p. 43)

You can change the 
camera’s start-up image 
and shutter sound.

Controlling Shooting 
from the Computer  
(p. 41)

To Send Email

Attaching 
Images to Email  
(p. 33)

You can reduce 
image file sizes. 

Previous

TEXT

ABC
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The Two ZoomBrowser EX Windows

Download Window/Organizing Window

The following two windows are the main ones used for ZoomBrowser EX procedures. 

Download window, which opens when a camera is connected.
CameraWindow 
View of camera images

You can download all or a selection of images from the connected camera. 

CameraWindow closes and the 
screen changes after the images are 
downloaded from the camera. 

Organizing window for downloaded images.
Main Window 

Double-click this icon 
on the desktop. 

You can view, edit and print the images in the computer. 

Double-click 
an image.

The Viewer Window that appears 
when you view an image.
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Main Window

How to Display the Main Window

The Main Window will display after camera images are downloaded and 
CameraWindow closes. You can also display it by double-clicking the 
ZoomBrowser EX icon on the desktop.

Names of the Main Window Parts

Menu Bar Function Buttons Display Control Panel

Task Buttons
Selects tasks to 
perform.

Last Acquired Images
Displays the last images 
downloaded.

Folder Area
Selects a folder 
to display.

Browser Area 
Icons that indicate 
image properties display 
around images, as 
shown on the left. 

Properties Icon (Displays image properties)

	 : Image recorded using the camera’s Stitch Assist mode

	 : RAW image

	 : Movie

	 : Image with sound memo attached

	 : Protected image

	 : Image recorded using the camera’s AEB function

	 : Rotated image (rotated in display only)
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How to Perform Tasks

Selecting Tasks and Task Window Procedures

Many ZoomBrowser EX functions can be accessed by selecting a task in the Main 
Window and following the instructions in the guidance section of the new window. 

	1 Select a task.

The major steps for the 
task appear here.
Follow the steps in order.
You can return to a 
previous step.

An overview for the 
selected task appears here.

Cancels the procedure and 
returns to the previous 
window. 

	2 Follow the instructions 
to perform the task.
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Downloading Images

Downloading Images by Connecting the Camera to a Computer

Download the camera images to the computer.

 IMPORTANT
•	The instructions in this software manual assume that you have correctly installed 

the software and driver software. See the guides supplied with your product 
package for software installation procedures.

•	With some versions of Microsoft Windows, CameraWindow may not open when 
the camera is connected. In this case, double-click the ZoomBrowser EX icon on the 
desktop to start ZoomBrowser EX and open the Main Window. Click the [Acquire & 
Camera Settings] task button, followed by [Connect to Camera].

	1 Connect the camera to the computer 
with the supplied interface cable. 

	2 Turn on the camera power, set it to 
playback mode and prepare it to 
communicate with the computer. 

	3 When a window similar to the one at the right 
appears, select [Canon CameraWindow] and 
click [OK].  
With Windows Vista, click [Downloads Images 
From Canon Camera using Canon CameraWindow] 
in the AutoPlay window. 
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CameraWindow 

	4 Click [Transfer Untransferred 
Images]. 
The images will start to 
download.

When you click [OK] in the 
dialog that indicates the transfer 
is complete, the downloaded 
images will display in the Main 
Window.
You can select the newly 
downloaded images by their 
shooting dates or My Category 
(select models only) classification. 
(These are virtual folders.)

 : Folders containing 
newly acquired images

•	 Images from memory cards with large numbers of images (more than 1,000) may not download 
correctly. If this happens, please use a memory card reader to download. 

 HINT
Changing the Download Destination Folder 
The default settings save downloaded images into the [Pictures] or 
[My Pictures] folders. To change the destination folder, select [Operate 
Images on Camera] in CameraWindow, then click the button shown 
on the right, and select a folder. 
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 HINT
Selecting Images to Download
To download only a selection of images from the camera, select [Operate Images on Camera] in 
CameraWindow that first appears and then perform the following procedures. 

1   Select images to download.

2   Start the download. 

Downloading Using Camera Commands 
With Windows Vista or Windows XP, you can use the camera’s  (Print/Share) button to download 
the images to the computer (Direct Transfer). See the Camera User Guide for Direct Transfer settings and 
procedures. 

Downloading from a Memory Card Reader
An action selection window will open when you insert a memory card into the memory card reader. If you 
select [View/Download Images Using Canon ZoomBrowser EX], ZoomBrowser EX will start and display the 
following window. Use this window to perform the downloading procedures. 

Downloads all images that have not yet been 
downloaded.

Allows you to select and download images. 

Prints images.

Configures the download folder 
and other settings.
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	2 Click [Photo Print].

	1 Click the [Print & Email] task button in the Main 
Window.

Printing

Printing a Single Image on a Single Page

Prints one image per page. 

	3 Confirm that [1. Select 
Images] is chosen and select
images for printing.

CO
PY



Basic Functions  
& Features

Contents Things to  
Remember

Mastering  
the Basics

More Advanced 
Techniques

Appendices

14

	4 Click [2. Printer and Layout Settings] and set the categories as desired. 

Sets the printer, paper 
size and borderless 
printing settings.

Click here to crop and print a portion of an image.

Click here to insert 
text onto an image 
and print. 

Sets the shooting date/time imprint settings.

	5 Click [3. Print].
Printing will start. 

 HINT
Printing Using Other Software
If you have specialized printing software installed on the computer, you can also use it to print the 
images. Click the [Print & Email] task button in the Main Window, followed by [Print Using Other 
Software]. 
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Index Print

Prints an index of the images. 

	1 Click the [Print & Email] task button in the Main 
Window.

	2 Click [Index Print].

	3 Confirm that [1. Select 
Images] is chosen and select
images for printing.

CO
PY



Basic Functions  
& Features

Contents Things to  
Remember

Mastering  
the Basics

More Advanced 
Techniques

Appendices

16

	4 Click [2. Printer and Layout Settings] and set the categories as desired. 

Sets the printer and 
paper size settings.

Rotates selected 
images.

Click here to crop a 
portion of the selected 
image and print it. 

Select an image to 
rotate or trim. 

Sets the number of 
rows or columns.

Configures the printing of the shooting information, 
comments, headers, footers or page numbers. 

	5 Click [3. Print].
Printing will start. 
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How to Use CameraWindow

First Window to Open

This is the first screen to appear in CameraWindow.

Downloads all images that have 
not yet been downloaded.

Closes this window and opens a 
camera image browser window that 
lets you select and download images.  
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Screen Showing the Image Index List and Image View

The Thumbnail Window on the left of the screen displays the images on the memory 
card in the camera as “thumbnails” or small versions of the images in an index list. 
When you select an image from the Thumbnail Window, the image displays in the 
View Window on the right.  

Thumbnail Window View Window

Aligns the windows.

Switches between 
window display modes.

Configures settings such as the 
thumbnail size and download folder. 

Configures the name 
of the camera owner.

Uploads computer 
images to the camera. 

Selects all images/images 
not yet downloaded.

Downloads images selected 
in the Thumbnail Window. 

These arrows switch the 
image in the View Window.

Closes 
CameraWindow. 

Prints images selected in 
the Thumbnail Window. 

 HINT
Use the Help Function

The Help button  or Help menu is available in most ZoomBrowser EX windows. It is there for when 
you are unsure how to proceed.
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How to Use the Main Window

Main Window

This is the main window for performing tasks in ZoomBrowser EX.

Slide Show
Displays the selected 
images in succession in the 
window.

Properties
Displays information 
about a selected image.

View Image
Displays the selected image 
in the Viewer Window. 

Task Buttons
Selects a task to perform.

Search
Performs searches on images.

Delete
Deletes the selected images or folders.
•	 Deleted images are sent to the Recycle 
Bin on the desktop.

•	 The association between a sound memo 
and an image cannot be recovered from 
a file restored from the Recycle Bin. 

Rotate
Rotates a selected image.
•	 Click the [Edit] menu and select [Rotate 
According to Rotation Information] to 
rotate the original image as well in the 
displayed direction.

•	Movies can be rotated by clicking the 
[Export] task button followed by [Export 
Movie].

Last Acquired Image/Folder Area
Selects a folder to display.
•	 You can register folders you use 
often as Favorite Folders ( ). 
Register by clicking [Add]. 

Browser Area
Displays the images 
in an index list.

Display Control Panel
Configures the settings for 
displaying images in the Browser 
Area.
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Browser Area Tasks 

Display Mode
Selects a display mode for the Browser Area.

Zoom Mode: suited for 
surveying many images.

Scroll Mode: allows 
thumbnails to be viewed at a 
size suited for easy viewing.

Preview Mode: allows the 
image information to be read 
while viewing the image.

Change the Folder Level
The level of folder displayed can be changed with the 
following procedures.
•	 In Zoom mode, position the mouse cursor over the 
folder and click the  icon when it displays.

•	 In Scroll or Preview mode, double-click the  icon.
•	 To advance to a higher folder level, click the  icon.

Change the Display Size
You can change the 
display ratio (Zoom mode) 
or thumbnail size (Scroll 
mode) with the slider.

Select Images 
Clicking an image in the Browser Area selects that 
image. To select multiple images, hold down the [Ctrl] 
key while clicking images, or hold down the [Shift] key 
and click a starting and ending image to select a range 
of adjacent images.

Display Images
Double-clicking an image in the Browser Area (or 

selecting the image and clicking  (Display Image)), 
displays it in the Viewer Window.

Move, Copy Images
To move an image between folders, drag it over the 
destination folder and release the mouse button. 
To copy an image, hold the [Ctrl] key while releasing 
the mouse button as above.
You can also use the same procedures to copy images 
between Windows Explorer and the Main Window.

Create New Folder
To create a new folder in the Browser Area, 
click the [File] menu and select [New Folder].

 HINT
Right-Click Context Menus
Right-clicking over a window or image displays contextual menus. These menus contain the functions 
available in the current context as well as other convenient functions. Use the right-click menus to 
increase your efficiency.  
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Viewer Window

Double-clicking an image in the Main Window displays it in this window. 

Change the display magnification.
Zooming in displays the Navigator window 
to show the relative position on the image.

Edit an image.

Display the shooting information.
You can configure the information display by clicking 
the [Tools] menu and selecting [Preferences].

Display at full 
screen size.

Set the Star Rating.

Display multiple 
images side by side.

Shooting 
information

•	The [Display Original Image] button will display beneath RAW images in the Viewer Window. Click this 
button to display the converted image  in the Viewer Window.

•	Buttons appear beneath movies selected in the Viewer Window, allowing you to replay the movie or adjust 
the sound volume. With Windows Vista and Windows XP, the  (Frame Capture) button will appear 
beside the Star Rating section. Clicking this button extracts still images from the movie. 
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Editing Images

 IMPORTANT
•	The original image will be overwritten after an image is edited unless the file 

name is changed before saving it. To preserve the original image intact, change 
the file name when saving the edited image. 

•	This section introduces the procedures started by clicking the Edit task button. Images can also be edited in 
a similar way by clicking the [Edit] button in the Viewer Window.

Red Eye Correction

Restores eye appearance to the original color when light reflected from the flash 
makes them appear red. 

Procedures

1
 

[Edit] and [Edit Image].

2 Select an image.

3 [2. Select Editing Tool]

4 [Red Eye Correction]

5 [3. Finish]

•	Movies and RAW images cannot be 
edited. 

•	Click [Start] when Auto mode is selected.
•	Switch to Manual mode if Auto mode cannot correct the 
image and select the location of the eye to correct.  

Auto Adjustment

Automatically adjusts the image color balance and brightness. 

Procedures

1
 

[Edit] and [Edit Image].

2 Select an image.

3 [2. Select Editing Tool]

4 [Auto Adjustment]

5 [3. Finish]

•	Movies and RAW images cannot be 
edited. 
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Color/Brightness Adjustment

You can adjust image color balance and brightness using a variety of methods. 

Procedures

1
 

[Edit] and [Edit Image].

2 Select an image.

3 [2. Select Editing Tool]

4 [Color/Brightness 
Adjustment]

5 [3. Finish]

•	Movies and RAW images cannot be 
edited. 

Adjusting Sharpness–Emphasizing Outlines

Makes images appear sharper by emphasizing the outlines of subjects, such as people 
and objects. 

Tone Curve Adjustment

Level Adjustment

RGB Adjustment

Brightness, 
Saturation, 
Contrast

Procedures

1
 

[Edit] and [Edit Image].

2 Select an image.

3 [2. Select Editing Tool]

4 [Sharpness]

5 [3. Finish]

•	The Unsharp Mask [Radius] is the size 
at which the outline is detected and the 
[Threshold] is the standard value at which 
the outline is determined.

•	Movies and RAW images cannot be 
edited. 

Unsharp Mask

Sharpen

CO
PY



Basic Functions  
& Features

Contents Things to  
Remember

Mastering  
the Basics

More Advanced 
Techniques

Appendices

24

Trimming–Cropping a Portion of an Image

Use this to delete unnecessary portions of the image and leave only the necessary 
portions.

Procedures

1
 

[Edit] and [Edit Image].

2 Select an image.

3 [2. Select Editing Tool]

4 [Trim]

5 [3. Finish]

•	You can also input values or an aspect 
ratio to specify the trim area. 

•	Movies and RAW images cannot be 
edited. 

Inserting Text

Use this to insert text onto the image. 

Procedures

1
 

[Edit] and [Edit Image].

2 Select an image.

3 [2. Select Editing Tool]

4 [Insert Text]

5 [3. Finish]

•	Placing a checkmark in the [Antialias] box 
causes the text edges to blend in with 
the underlying image. 

•	Movies and RAW images cannot be 
edited. 

HELLO

You can freely adjust the font, 
size, color and text attributes.

CO
PY



Basic Functions  
& Features

Contents Things to  
Remember

Mastering  
the Basics

More Advanced 
Techniques

Appendices

25

Using Other Editing Software

If you register another image editing program with ZoomBrowser EX in advance, you 
can use that software to edit an image selected in ZoomBrowser EX.

Registering an Editing Program

Register the program so 
it can be started from 
within ZoomBrowser EX. 

Procedures

1
 

[Edit] and [Edit Image].

2 Select an image.

3 [2. Select Editing Tool]

4 [Edit with external image 
editor]

5 [Manage List]

ZoomBrowser EX Other Image 
Editing Program

Editing Images with a Registered Editing Program

Procedures

1
 

[Edit] and [Edit Image].

2 Select an image.

3 [2. Select Editing Tool]

4 [Edit Image Using Other 
Editor]

5 [3. Finish]

•	The shooting information may be lost 
from images recorded with the camera 
and then processed and saved with 
another image editing program.  

•	Movies and RAW images cannot be 
edited. 
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Attaching Sounds

You can add sound effects or background music to images and play back the sounds.

Adding Sound

Symbol displayed on image 
thumbnails to which sound 
files have been added.

Procedures

1 Select an image.

2
 

[Edit] and [Add/Remove 
Sound].

•	WAVE type sound files (extension 
“.wav”) can be attached to images. 

•	Attaching a sound file to an image results 
in the selected sound file being copied 
into the same folder as the image file. 

Playing an Image Sound File

Procedures

1 Select an image.

2
 

[Edit] and [Play Sound].

+
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Creating Panoramic Images–PhotoStitch

You can create wide panoramic images by moving the camera slightly when recording 
a series of images and merging them into one image.

 HINT
Using the Stitch Assist Mode 
If you use the camera’s Stitch Assist mode to record the images, PhotoStitch can automatically detect the 
image order and merge direction, making it easier to merge the images. (Some camera models may not 
feature the Stitch Assist mode.)

Editing Movies

You can create original movies by linking movie clips and still images. 
You can even add titles and other text, background music and various special effects 
to the movie.

Procedures

1
 

[Edit] and [Stitch Photos].

•	Movies and RAW images cannot be 
edited. 

Use the PhotoStitch program 
to create panoramic images.

Procedures

1
 

[Edit] and [Edit Movie].

 IMPORTANT
QuickTime is required to play movies on Windows 2000.

ABC
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Converting RAW Images

You can convert RAW images to JPEG and TIFF images.

Image type retaining 
the detailed image 
data from the initial 
capture.

Image type suited for pasting 
into word processing documents 
and general programs, and for 
sending by email. 

Exposure correction

Color adjustment

Lossless 
image 

adjustments 
possible

White balance adjustment

Color space configuration

Procedures

1
 

[Edit] and [Process RAW 
Images].

•	You can use the Image Quality 
Adjustment Window to adjust the image 
brightness and color to your satisfaction. 

 HINT
About RAW Images
RAW images contain the data captured by the camera’s image sensor without modification. Since they 
contain raw data that differs from the usual JPEG images by not having any image adjustment or compression 
processing performed in the camera, they can be converted on a computer with a lossless process. 

RAW JPEG, TIFF...

Processing in the Camera

Standard Image 
Capture

Image Adjustment

Compression JPEG Image

Image sensor 
data from 
shutter release

Image adjustment 
& compression 
automatically performed

RAW Image 
Capture RAW Image

Processing by Computer

•	 Can be used with general programs.
•	 Image is subject to degradation when 
adjusted because it has been compressed.

JPEG Image,
TIFF Image

•	 You can view the image while making 
adjustments without worrying about quality loss. 

•	 Processing with ZoomBrowser EX is required 
to view the images with general programs. 

Image Adjustment

Compression

ZoomBrowser EX  
RAW Image Processing

 IMPORTANT
•	RAW images can only be captured on certain camera models that list “RAW” as one 
of the data types included in the “Specifications” section of the Camera User Guide. 
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Exporting

Changing Image (Stills) Sizes and Types

You can change an image’s size and format when exporting it so that it can be 
published on the Internet or attached to an email message. 

Procedures

1
 

[Export] and [Export Still 
Images].

•	You will lose the shooting information 
if you save images as a type other than 
JPEG. 

Changing Movie Sizes and Types

You can change a movie’s size and format when exporting it so that it can be 
published on the Internet or attached to an email message.

Procedures

1
 

[Export] and [Export 
Movies].

•	You can also use this function to rotate 
movies. 

.bmp .jpg .tif

.avi

 IMPORTANT
•	The QuickTime program is required to play movies on Windows 2000.
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Extracting Stills from Movies

You can extract and save stills from your favourite frames recorded in a movie. 
(Windows Vista and Windows XP only)

Extract your best 
shots as stills

Procedures

1
 

[Export] and [Extract frames 
from a movie].

Exporting Shooting Information

You can export the shooting information recorded with an image, such as the shutter 
speed and exposure, as a text file.  

Ascertain the causes of 
failed photos or compare the 
settings for several images.

Procedures

1
 

[Export] and [Export 
Shooting Properties].
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Creating Computer Screen Saver Images 

You can export images to serve as computer screen savers. 

Creating Computer Wallpaper Images

You can export images to serve as computer wallpaper images.

Procedures

1
 

[Export] and [Export as a 
Screen Saver].

Procedures

1
 

[Export] and [Export as a 
Wallpaper].
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Saving to CDs

You can save images along with their shooting information to CD-R/RW discs. 
(Windows Vista and Windows XP only)

Back up important images 
or distribute your vacation 
photos on discs.

Procedures

1
 

[Export] and [Backup to CD].

 IMPORTANT
•	This function can only be used with computers that satisfy the following 

requirements:

•	Equipped with a CD-R/RW drive as standard equipment
•	Writing to the CD-R/RW drive operates correctly with Windows Vista or 
Windows XP. 

•	 If a window similar to that shown to the right appears when a 
new CD-R/RW disc is placed in the drive, click [Cancel] to close 
the window. 
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Email

Attaching Images to Email

You can send images as email file attachments. 

You can configure 
the image size and 
quality settings.

Procedures

1
 

[Print & Email] and [Email 
Images].

•	You can configure how the email 
program automatically starts up by 
starting the Internet Explorer program, 
and clicking the [Tools] menu, followed 
by [Internet Options], [Programs] tab, and 
the [E-mail] pull-down menu.
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Slide Shows

Viewing Images in Slide Shows

A multiple selection of images can be shown at full size on the screen in succession as 
a slide show. 

You can freely configure the 
transition effects, information 
displayed and display time settings.

Procedures

1
 

[View & Classify] and [View 
as a Slide Show].

 HINT
Slide Show Button Functions
The following buttons appear at the bottom of the screen while a slide show is playing. 

You can set the Star 
Rating for an image 
while it is displayed. Rewind Pause Forward

After the slide show, 
the images you 
clicked during the 
show remain selected.

After the slide show, 
the images you clicked 
during the show appear 
in a printing window. 

Stops the slide show.
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Image Management

Changing File Names in Batches 

You can change the file names of multiple images in one procedure.

Name + Number

Shooting Date + Number

Name + Shooting Date + Number

Shooting Date + Name + Number
 

Change randomly 
numbered images 
and received images 
into consecutively 
numbered images. 

xxx_01 xxx_02 xxx_03 xxx_04 xxx_05

Procedures

1
 

[View & Classify] and 
[Rename Multiple Files].

•	You can change individual file and folder 
names by clicking the [File] menu and 
selecting [Rename] or by clicking on the 
file name in Preview mode. 

•	Changing the image name in 
ZoomBrowser EX also changes the actual 
file name on the disk. 

Sorting Images into Folders by Shooting Date

You can sort images into folders by their shooting dates.

Images predating your use 
of ZoomBrowser EX can 
also be managed together. 

Procedures

1
 

[View & Classify] and 
[Classify into Folder].

200x/05/15

200x/05/16

200x/05/17
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Configuring Image Information Settings

Setting Star Ratings

You can set the Star Ratings used in searching and displaying images in the index list.

: Ultimate
: Moderate
: Okay

Procedures

1
 

Switch to [Preview Mode].

2 Set [Star Rating].

•	You can also set the Star Ratings by 
accessing the [Edit] menu, the Properties 
Window or the Viewer Window.

Inserting Comments

You can freely insert your choice of text as Comments.

Trip to the blue sea

Endless white
 

sandy beache
s

Relaxing 
afternoon 
snooze

Your choice of text 
as comments

Procedures

1
 

Switch to [Preview Mode].

2 Insert [Comment].

•	Comments can also be managed in the 
Properties Window. 
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Family, Animals

Family, Trips

Friends, Holidays

Assigning Keywords

You can set Keywords for use in image searches.  

Select keywords

Procedures

1
 

Switch to [Preview Mode].

2 Insert [Keywords].

•	Keywords can also be managed from the 
[Tools] menu or Properties Window.

•	To add keywords, click the [Tools] menu 
and select [Manage Keywords].

 HINT
About the Image Information
This chart shows the information other than shooting information that can be added to images.

Information Type My Category Star Ratings Comments Keywords

Content
Categories such as 
People, Scenery, etc.

Rated on basis of 3 
rankings: , , 

Text input without 
restriction regarding 
the shooting 
circumstances 
or associated 
memories.

Selections are made 
from a list (editable) 
of keywords, such 
as the photographic 
subject, place or 
action. 

Configuration 
Method

Configured in 
Camera

Configured in ZoomBrowser EX

Used in Searches — O O O

Used as Filter 
Criteria

O O — —

Display beneath 
Thumbnail

O O O —

Categories displayed beneath thumbnails can be selected by clicking  in the Display Control Panel.
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Searching, Filtering and Sorting Images

Searching Images

You can search images using parameters extracted from the information associated 
with them.  

Star Ratings

Shooting Dates

Revision Dates

Comments

Keywords

Procedures

1
 

[View & Classify] and 
[Search].

•	After a search, the correlated images 
display in the [Search Results] folder. 

 HINT
Tasks Related to Search Results
You can select images in the [Search Results] folder and perform operations on them, such as printing or 
copying them to other folders. 

 IMPORTANT
•	Please note that deleting an image from the [Search Results] folder deletes the 

original image. Use caution in deleting items from this folder. 
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Procedures

1 Select an image.

2
 

[View] and [Sort by].

Filtering Images

You can use filters to display only images meeting the selected parameters in the 
Browser Area.

Star Ratings My Category

Procedures

1
  

[Filter]

This section is used to specify the filter criteria.

Sorting Images

You can sort images in the Browser Area based on the specified parameters. 

Name

Star Rating

Shooting Date

Modification 
Date

Type

Ascending/
Descending 

Order

A B C D E

A BCD E
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Comparing Images

Comparing Multiple Images

When a good photo opportunity arises, you can shoot the same subject using different 
shutter speeds and exposures. In ZoomBrowser EX, it is easy to compare images so that 
minute differences can be detected.

Procedures

1 Select several images to 
compare.

2 Click  View Image.

3 Select ,  or  in 
the Viewer Window.

4 Click  Synchronize.

•	Selecting [Synchronize] causes actions 
such as increasing/reducing the 
magnification level or scrolling around 
the image to apply to all of the selected 
images in lock step, making it easy to 
check minute details of focus, coloring 
and other image characteristics.  

Actions, such as scrolling or changing the magnification, are performed 
on both images no matter which image it is performed upon.  

CO
PY



Basic Functions  
& Features

Contents Things to  
Remember

Mastering  
the Basics

More Advanced 
Techniques

Appendices

41

Remote Shooting

Operating the Camera Using Computer Commands

You can activate the shutter of a connected camera from the computer

Also useful for fixed position 
or unmanned recording. 

Procedures

1 Connect the camera to the 
computer.

2 Turn on the camera power, 
and set it to playback mode. 

3 If the [Select program to 
launch for this action] (or 
AutoPlay) dialog opens, 
click [Cancel] (or  
in Windows Vista). If 
CameraWindow opens, 
click [Operate Images on 
Camera], followed by .

4 Click  [Start], 
followed by: [All Programs] 
or [Programs], [Canon 
Utilities], [CameraWindow], 
[RemoteCapture DC3], 
[RemoteCapture DC].

 IMPORTANT
•	Remote shooting is only available with certain camera models that list it as one 
of the features in the “Specifications” section of the Camera User Guide. 

•	Ensure that you turn off your computer’s standby feature before you begin 
remote shooting. The results cannot be guaranteed if the computer enters the 
standby mode while remote shooting.

•	Except for the shutter button, the camera’s buttons and switches, including 
the zoom, cannot be manually operated while the camera is being remotely 
controlled.

•	The time lag between pushing the shutter button and the release of the shutter 
is slightly longer for remote shooting compared with the normal mode of 
operation.
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Remote Shooting Window

Selects the image’s recording 
size and compression.

You can add a comment 
to an image.

Viewfinder

Sets the shooting settings.

Sets the rotation setting of the 
image being recorded.
This setting cannot be adjusted 
if the [Auto Rotate] function of 
your camera is set to [On].

Releases the camera shutter (you 
can also release it by pressing 
the camera’s shutter button or 
the space bar on the keyboard).

Sets the camera’s zoom.

Turns the viewfinder 
display on or off.

Resets the exposure, focus 
and white balance settings.

 HINT
Interval Timer Shooting
This method captures a set number of frames recorded at set intervals of time. Click the [Shooting] menu 
in the remote shooting window and select [Interval Timer Shooting]. (Short intervals may be insufficient 
for image transmission and saving, resulting in the failure to capture images at the specified interval.)

Timer Shooting
This method captures a single image after a set number of seconds. Click the [Shooting] menu in the 
remote shooting window and select [Timer shooting]. The timer interval settings range from 2 seconds to 
30 seconds.

Displaying Subjects on the Camera’s LCD Monitor
You can use the camera’s LCD monitor or a television connected to the camera to view the subject while 
shooting remotely. Click the [Camera] menu in the remote shooting window and select [Camera Display 
Settings]. See the Camera User Guide for TV connection instructions.

Shooting Without Worrying about Memory Card Capacity
Clicking the [File] menu in the remote shooting window and selecting [Preferences] opens the Preferences 
window. If you place a check mark beside [Computer only] in the [Save Images On] section, you can 
continue recording without worrying about free space on the camera’s memory card.  
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My Camera Settings

Changing the Shutter Sound and Start-Up Image

The camera’s start-up image, start-up sound, shutter sound, operation sound and self-
timer sound are collectively referred to as My Camera Settings. You can register your 
own custom images and sounds as the My Camera Settings.

My Camera Settings
•	 Start-up Image
•	 Start-up Sound
•	 Shutter Sound
•	Operation Sound
•	 Selftimer Sound

Procedures

1 Connect the camera to the 
computer.

2 Turn on the camera power, 
and set it to playback mode. 

3 If the [Select program to 
launch for this action] (or 
AutoPlay) dialog opens, 
click [Cancel] (or  
in Windows Vista). If 
CameraWindow opens, 
click [Operate Images on 
Camera], followed by .

4 Click  [Start], 
followed by: [All Programs] 
or [Programs], [Canon 
Utilities], [CameraWindow], 
[MyCamera], [MyCamera].

5 Click [Connect to Camera].

 IMPORTANT
•	My Camera Settings are only available with certain camera models that list them 
as features in the “Specifications” section of the Camera User Guide. 

•	Do not interrupt the connection between the camera and computer when My 
Camera Settings are being transmitted between them. 

•	With Windows Vista, the settings files originally supplied with ZoomBrowser EX 
cannot be deleted.

CO
PY



Basic Functions  
& Features

Contents Things to  
Remember

Mastering  
the Basics

More Advanced 
Techniques

Appendices

44

You can register the start-up 
image, start-up sound, shutter 
sound, operation sound and 
self-timer sound collectively if 
you select [Setup as a theme].

My Camera Settings 
registered in the camera.

My Camera Settings 
in the computer.

After selecting a My Camera Settings file from the left-hand list, 
select a My Camera Settings file to replace in the right-hand list 
and click this button to register it in the camera. 

 HINT
Creating My Camera Settings
You can create your own original My Camera Settings files using My Camera Maker, a supplied program. 
To start My Camera Maker, select the [Set individually] tab in the My Camera window and click [Create 
My Camera data].

* The volume control knob in My Camera Maker sets the volume level in the saved sound file itself. If you 
think the volume is too loud when replayed on the computer and set it low when you save the file, the 
sound may not be audible when it is registered to the camera. To adjust the playback volume on the 
computer, please use the volume controls for the computer or speakers.

Use the following specifications to create My Camera Settings files if you are using an alternative program 
to My Camera Maker.

Start-up images:	 Compression Method: JPEG (Baseline JPEG)
	 Data Sampling: 4:2:0 or 4:2:2
	 Pixels (w x h): 320 x 240 pixels

Sound files:	 Compression Method: WAVE (Monaural)
	 Quantifying Bits: 8 bit
	 Sampling Frequency: 11.025 kHz or 

8.000 kHz (Use the chart on the right 
as a guideline for the length of sound files recorded with the camera.)

Type Duration in Seconds

11.025 kHz 8.000 kHz

Start-Up Sound 1.0 sec. or less 1.3 sec. or less

Operating Sound 0.3 sec. or less 0.4 sec. or less

Self-Timer Sound 2.0 sec. or less 2.0 sec. or less

Shutter Sound 0.3 sec. or less 0.4 sec. or less
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Uploading Images

Uploading Images to a Camera

You can upload images from a computer to a memory card in a camera. 

Procedures

1 Connect the camera to the 
computer.

2 Turn on the camera power, 
and set it to playback mode. 

3 Select [Canon CameraWindow] 
(with Windows Vista, select 
[Downloads Images From 
Canon Camera using Canon 
CameraWindow].

4 Click [Operate Images on 
Camera].

Show favorite images 
to friends or connect 
a TV to show them 
on a large screen.

 IMPORTANT
•	Only images compliant with Design rule for Camera File system standards can be 
uploaded to your camera’s memory card.

5 Click  (Send to Camera).

•	 If the Main Window is open when 
the camera is connected (directly 
after downloading for instance), open 
CameraWindow by clicking the [Acquire 
& Camera Settings] task button, followed 
by [Connect to Camera].
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Preference Settings

Customizing ZoomBrowser EX

You can configure ZoomBrowser EX to operate according to your preferences.

•	Overall themes, such as 
window appearances

•	 Processing methods for 
images shot with the 
camera on end

•	 Categories of shooting 
information displayed

•	 Show/hide messages
•	 Print settings
•	 Zoom speed

Customizing the Task Buttons

You can hide items that you do not usually use to streamline the task buttons. 

Procedures

1
 

[Tools] and [Preferences].

Procedures

1
 

[Tools] and [Customize].
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Supported Image Types
The following is a list of image types supported by ZoomBrowser EX.

JPEG (.JPG)
Most cameras use this image type. It compresses at very high ratios, taking advantage 
of the characteristics of the human eye. However, because it is an irreversible 
compression method (part of the data is lost during compression), if you process and
save an image repeatedly using this method, the image may become rougher.

RAW (.CRW/.CR2)
This is a proprietary image type provided by Canon. It saves the output of the image 
pixels from a digital camera without any deterioration in the quality of the image. 
Some cameras might not support this image type.

Windows bitmap (.BMP)
This image type comes standard with Windows. Most Windows programs support it.

TIFF (.TIF)
This is a relatively popular image type. It is widely supported by non-Windows 
programs (such as Macintosh).

PhotoCD (.PCD)
This is the image type used for Photo CDs.

Video clip (.AVI)
Standard Windows movie image type. The movie thumbnail and a movie icon show in 
ZoomBrowser EX’s Browser Area.

QuickTime (.MOV)
This is a movie which displays as a movie icon in the Browsing Area of ZoomBrowser EX.

MPEG4 (.ASF)
Movies that integrate multimedia data, such as video, audio and text. Primarily used 
by Windows programs. The MPEG4 compression technology allows for compact file 
sizes and delivery over networks.
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New Features in This Version
The following features were added or changed in this version of ZoomBrowser EX. 
(ZoomBrowser EX Ver. 5.8 to 6.1)

CameraWindow Makeover 
CameraWindow has been completely revamped to make the linkage tighter between 
Canon brand cameras and ZoomBrowser EX and to add convenience and functionality. 
It may not be possible to use the new CameraWindow with some camera models.

Changes to Memory Card Downloading Methods 
The Camera Control Window was used in prior versions to download images from 
memory card readers. These downloads are now performed as a ZoomBrowser EX task 
in the Main Window. The data reading speed has also been significantly accelerated.

Text Insertion Feature Added to Printing Functions
In addition to the ability to print such information as the shooting date with the 
image, you are now able to add text freely during the printing preparation. Greeting 
cards and photos bearing messages can now be made with ease. 

Task Button Revisions
The task button composition has been revised to make the tasks more intuitive.

•	The starting point for the “Sending images by email” process has shifted from the 
[Internet] button to the [Print & Email] button. CO
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Software User Guide     Windows     (ZoomBrowser EX, PhotoStitch)

Disclaimer
•	While every effort has been made to ensure that the information contained in this guide 
is accurate and complete, no liabilitycan be accepted for any errors or omissions. Canon 
reserves the right to change the specifications of the hardware and software described 
herein at any time without prior notice.

•	No part of this guide may be reproduced, transmitted, transcribed, stored in a retrieval 
system, or translated into any language in any form, by any means, without the prior written 
permission of Canon.

•	Canon makes no warranties for damages resulting from corrupted or lost data due to a 
mistaken operation or malfunction of the camera, the software, memory cards, personal 
computers, peripheral devices, or use of non-Canon memory cards.

Trademark Acknowledgments
•	Microsoft, Windows Vista and the Vista logo are trademarks or registered trademarks of 
Microsoft Corporation in the United States and/or other countries.

•	Macintosh, the Mac logo, QuickTime and the QuickTime logo are trademarks of Apple, Inc., 
registered in the U.S. and other countries.

CDA-E015-010	 © CANON INC. 2008
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